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Arduino nedir?

Arduino Cag1 Basliyor

Arduino kolay bir sekilde gevresiyle etkilesime girebilen
sistemler tasarlayabileceginiz, hem acemi hem de ileri
diizeydeki elektronik meraklilarina hitap eden, kolayca
programlanabilen ve iizerine elektronik devre kurulabilen
agik kaynakli bir gelistirme platformudur.

ARDUINO

arduino.cc

Fiziksel Diinya i¢in Bir Bilgisayar

Bu elinizde tuttugunuz dost canls: mavi karti masatisti
bilgisayarlarimizin ve laptoplarmnizin gocugu gibi
tagmabilir kiigiik bir bilgisayar olarak diistinebilirsiniz.
Arduino kiitiiphaneleri ile mikrodenetleyicileri
kolaylikla programlayabilirsiniz. Analog ve dijital
girigleri sayesinde analog ve dijital verileri isleyebilir ve
sensorlerden gelen verileri kullanarak dis diinyaya
ciktilar (ses, 151k, hareket vs...) retebilirsiniz.

Arduino kartlar1 bir Atmel AVR mikrodenetleyici

programlama ve diger devrelere baglanti i¢in N\ /7
gerekli yan elemanlardan olusur. Her kartta en

azindan bir 5 voltluk regiile entegresi ve bir J— —
16MHz kristal osilator (bazilarinda seramik

rezonator) bulunur. Mikrodenetleyiciye dnceden
bir bootloader programi yazili oldugundan
programlama igin harici bir programlayicrya
ihtiya¢ duyulmaz.

/ ARDUINO \

// Arduino UNO smp r3

Arduino Uno en yaygin kullanilan arduino kartidir.
14 dijital giris / ¢ikig'a (6 PWM g¢ikis1), 6 analog
girise, bir 16 MHz kristal osilatore, bir USB
baglantisina, bir giig girisine, bir ICSP baghgina ve
bir reset diigmesine sahiptir. Heyecana kapilmaya
gerek yok egitim igerisinde tekrar bu konulara
deginilecektir.§imdilik yiizeysel olarak bilinmesi
yeterlidir.




e Sayach Bocek Yakalama o Kamera Zamanlama Uygulamasi 0 Kahve Makinesi
0 Oyuncaktan Email Habercisi o Otomatik Cigek Sulama o Quadcopter
0 Otomatik Ayakkab1 Bagcigi o Programlanabilir Trafik Isiklar1



Arduino IDE'yi Indirme (Entegre Gelistirme Ortami)

Internet Erisimi

Arduino ile yazihm gelistirmek ve ¢alistirmak icin 6ncelikle
www.arduino.cc sitesinden bir Arduino Entegre Gelistirme
Ortami indirmeliyiz. Arduino IDE olarak bilinen bu yazilim
arduino 'yu programlamak icin adeta bir kelime islemci
gorevi gorecektir. Internet tarayicinizdan asagidaki adrese
tiklayarak size uygun Arduino IDE ‘yi indirebilirsiniz.

m arduino.cc/en/Main/Software

7
Kullandiginiz isletim sistemine gore size uygun

Yiikleme olan Arduino programini segmek igin arti(+)
isaretine basmaniz yeterlidir.

+ Windows
+ MacOS X
4+ Linux: 32 bit, 64 bit

+ source

ARDUINO =
— T R

Dowalned the Arduing Software

0 Bilgisayarmz, igin sygun isletim sistemine gore yiikleme paketi seqmeyi unutmayimsz.



/I Arduino Uno'yu Bilgisayara Baglamak

Arduino ve Bilgisayar1 USB ¢ikislarindan USB Kablosu ile bagliyoruz.

il
I jls

// Surticii Yiikleme

Windows Siiriicii Yiikleme
Asagidaki adreste Windows siirticii yiiklemesi ileilgili
talimatlar1 bulabilirsiniz.

3 Bilgisayarinizin isletim sistemine gore ihtiyaciniz olan siirticiiyti indirip yiiklityoruz.

bttp://arduino.cc/en/Guide/Windows

Macintosh OS X Siiriicii Yiikleme

/ = > Asagidaki adreste MacOSX stirticii yiiklemesi ile ilgili talimatlar
- bulabilirsiniz.
\ _ 4

bttp://arduino.cc/en/Guide/MacOSX

Linux: 32 bit / 64 bit Siiriicii Yiikleme

Asagidaki adreste Linux stirticti yiiklemesi ileilgili talimatlar:
bulabilirsiniz.

bttp://www.arduino.cc/playground/Learning/Linux



//Arduino IDE yi A¢iyoruz:

Oncelikle bilgisayarimiza indirdigimiz arduino gelistirme programini
agalim. Programlamaya ge¢gmeden 6nce biraz gelistirme ortamini
kurcalayalim.




(¢10] | (Grafik Kullanic1 Arayiizii)

1 Verify(Derleme): Yazmis oldugunuz kodu derler. Soz dizimi hatalarinizi bulur.

Ozellikle ha
7 ' Sketch Name: $u an da iizerinde caligtiginiz sketch in adim gosterir.
8 Code Area(Kod Alani): Sketch igin kod olusturacaginiz alandr.

9 Message Area(Mesaj Alani1): Kodunuzdaki hatay: gosteren alan .

// Bu klavuz i¢in en 6nemli ii¢ komut agagida goriilmektedir:

Open(Ag¢mak)

Verify(Derleme)

Upload(Yiikleme)




// Seri aygit1 Segmek

//Kartimiz1 Secelim: Arduino Uno

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Port

Programmer
Burn Bootloader

, > WL

> Arduino Duemilanove w/ ATmega328]

Arduino Diecimila or Duemilanove w/ ATmega168
Arduino Nano w/ ATmega328

Arduino Nano w/ ATmega168

Arduino Mega 2560 or Mega ADK

Arduino Mega (ATmega1280)

Arduino Mini

Arduino Mini w/ATmega168

Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ATmega168

LilyPad Arduino w/ ATmega328

LilyPad Arduino w/ ATmega168

Arduino Pro or Pro Mini (5V, 16 MHz) w/ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ATmega168
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ATmega168
Arduino NG or older w/ ATmega168

Arduino NG or older w/ ATmega8

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Board 4
Seralpor >
Aygitimiz icin uygun olan seri portu segmek icin Tools com 12
V8 . S g" = P ek g Programmer
>Setial Port mentisiine tikliyoruz. Genelde com3 veya Burn Bootloader
tizeridir (COM1 ve COM2 genellikle donanim seti portu
olarak kullaniimaktadir). Kullanacagmniz arduino portunu
bulmak i¢in Arduino ile bilgisayar arasindaki baglantiyt
kesin ve meniiye tekrar gelin ,baglantiy1 kestikten sonra
menude kaybolan pott sizin Arduino portunuzdur.
O portu secip arduino programlamaya baslayabiliriz.
I Auto Format
Archive Sketch
~ Fix Encoding & Reload
L& Serial Monitor
A ad Board »
Serial Port » /dev/tty.usbmodem262471
/dev/cu.usbmodem262471
Programmer »

Aygitimiz icin uygun olan seti portu segmek icin Tools
>Serial Port meniisiine tikliyoruz.Mac bilgisayarlarda
Uno veya Mega 2560 icin (/dev/tty.usbmodem) ve
ya eski kartlar icin (/dev/tty.usbserial) seciyoruz.

g

/dev/tty.Bluetooth-Modem
/dev/cu.Bluetooth-Modem
/dev/tty.FireFly-7256-SPP
/dev/cu.FireFly-7256-SPP
/dev/tty.tiPhone-WirelessiAP-1
/dev/cu.tiPhone-WirelessiAP-1
/dev/tty.Bluetooth-PDA-Sync
/dev/cu.Bluetooth-PDA-Sync

Burn Bootloader

http://www.arduino.cc/playground/Learning/Linux



AkademikPort Arduino Kodu indirme ( Kitapgigimizdaki Devreleri Olusturmak I¢in)

AKADEMIKPORT

Indirmek igin agagidaki baglantiy1 takip edin;

kitap.akademikport.com

° — [ start —» [ Programs —¥» [ arduino —» [ examples

Adreste verdigimiz
sikistirilmis dosyayi indirip,
icerisindeki “Arduino Kod”
dosyasini digari ¢ikartiyoruz.

“Arduino Kod” dosyasini kopyalayip arduino kurulumu
icerisindeki "examples" klasoriiniin igerisine yapistirtyoruz.

@ Contents

2 e '
8 Resources

s } |
E ) Arduino 'yu uygulama dosyasindan *

buluyoruz. Arduino 'ya sag

| Java
o tikliyoruz(ctrl + click) . “Show
Adreste verdigimiz sikistirilmig Package Contents” 'i seciyoruz. *
dosyay1 indirip, icerisindeki
« . . 8 examples
Arduino Kod” dosyasini digar1 Arduino
kartiyoruz. Open . ,
S 4 ‘Arduino Kod” dosyasini
Kopval 1
Move to Trash ©OoyelEp el
Kklasoriiniin ierisine
vapistiryoruz.

http://www.arduino.cc/playground/Learning/Linux

\'"‘




Elektrik Devreleri

Elektrik Devresi Nedir?

Elektrik Devresi basitge baglangig ve bitis noktasi olan ve
igerisinde bir ¢ok devre elemani buluduran déngiidir.
Devreler her 6lgiide ve sekilde yiizlerce ; direng,diyot,
bobin,sensér, motor ve diger devre elemanlarini
barindirabilir.

Devreler genelde analog devreler,dijital devreler ve
karigik sinyal devreleri olmak tizere ii¢ kategoriye
ayrilir.Bu kitapgikta her ii¢ devre gesidi de
gosterilecektir.

Diinya Bu Devreler Uzerinde Doniiyor

Nereye bakarsaniz bakin devreler ile karsilasacaksiniz.
Cebinizdeki telefon, aracinizin emisyon sistemini
kontrol eden bilgisayar,oyun konsollariniz,elektrikli
mutfak aletleriniz , bunlarin hepsi elektrik devreleriyle
dolu. Bu kitapgikta bazi basit devreleri deneyecek ve
gomili elektronik sistemlerinin temeline adim

atacaksiniz.

+
I
o
o
o
o
@
ES
+
]

/1 Basit ve Karmagik Devreler

Bu kitapgikta ilk olarak basit devreleri
kesfedeceksiniz. Ama bu sizin basit araglarla
biiyiileyici seyler yapamayacaginiz anlamina
gelmiyor elbette. Bu egitimi tamamladiktan
sonra devreler hakkinda 6grendiginiz bilgiler
hayal giiciiniize de bagli olarak muhtesem
projeler yapmanizi saglayacak.
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Devre Elemanlari

Atlama Kablosu
Cesitli Renklerde

/

Il

LED (5mm)
(Light Emitting Diode)

x10

([e—=

x1

3300 Direng
&
x25 Gergek Goriiniim

10KQ Direng

x25

&

Gergek Goriiniim

Potansiyometre

¢ B

Diyot
(1N4148)

“Gergek Goriiniim

Foto Direng¢(Lpr)

Buzzer

Sicaklik Sensorii Transistor -
D<o
e B || oo, BB
ON ON
x1

DC Motor

)i

Push Buton
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x1

Servo Motor

Role

x1

Entegre (i)
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Arduino Uno

9-12V DC Giig Girisi( Barrel Jack) - 9V veya 12V gii¢ baglanabilen giic girisidir .
USB Baglant1 Konnektorii(USB Port) - Arduino 'ya program yiiklemek ve bilgisayar ile haberlesmek i¢in kullanilan baglant1 konnekterd:
LED(RX: Receiving) - Seri haberlesme i¢in kullanilan RX pininin durumunu gésteren LED'dir. Veri alisverisi oldugunda bu led yanar.

LED(TX: Transmitting) - Seri haberlesme i¢in kullanilan TX pininin durumunu gosteren LED'dir. Veri aligverisi oldugunda bu led yanar.

LED (Pin 13: Troubleshooting) - 13 Nolu dijital pine bagh olan LED'dir. Programlar: test etmek i¢in kullanilabilir.

in kullanilan pinler burada bulunuyor.Yaninda isareti bulunan pinler aym
LED (Gii¢ LED"i)-Kartimizin gii¢ gosterge LED 'idir. Devrelerinizi kurarken kisa devre yapip yapmadiginiz bu LED 'e bakarak anlayabilirsiniz.
Reset Butonu -Arduinoyu yeniden baslatir.Programlarimiz setup() fonksiyonundan itibaren yeniden baslar.
Kart Uzerinde Programlama(ICSP) Pinleri - Atmega microdenetleyiciyi harici bir programlayici ile programlama pinleri.

Anolog G1r1§ Pinleri ve Gllg: Baglantllarl =Anolog giris ve gerilim baglantilar1 bu béliimde bulunuyor.Ayrica analog-dijital
geviricinin referans giris pini ve seri iletisim pinleri de (RX ve TX) burada bulunuyor.

// Pin Diyagrami
Header pinleri devreleri kurmak igin en 6nemli yerlerdir. Biraz
o zaman ayir1p arduino uno iizerindeki giris ¢ikiglara goz gezdirelim.
SCL B
SDA
AREF ARef
— GND Ground
AR 13 Digital
IOREF »
12 Digital
Reset RESET
~11 Digital
Power Out 3.3v
~10 Digital
Power Out 5V
~9 Digital
Ground GND iak
o 8 Digital
Ground GND g
@ Power In VIN T 7 Digital
g ~6 Digital
Analog Ao ° = Digital
Analog Al - 4 Digital
> 2 1
Analog A2 § s -3 Digital
Analog A3 5 E 2 Digital
Analog A4 ; ™S1 X - Out
Analog A5 RX < 0 RX-In

@)

O

A =PWM/Analog ¢ikis uyumlu (i.e~3)
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Bu ¢izgi breadboardumuzu ikiye boliiyor,Her boliim kendi i¢inde bagimsizdir.




Breadboard

1 Dikey Baglantl (+ Giig ve - Toprak = Asagidaki diy: a B:

2 Yatay Baglanti (a-e&f-j Asagidaki diyagrama Bakiniz

+++++++

1

30|
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Breadboardin f¢ Goriiniimii>>>
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Devreler #1 - Ilk Devren

Nasil Calistiracagiz;

Arduino' ya
Yiikle

3

2 Kodu Yaz

Parcalar1
Birlestir

1

+ USB Kablosunu Bagla

Breadboard hakkinda genel bilgiler verildi,
simdi arduino ile breadboardu yanyana
yerlestirelim ve talimatlara dikkat edelim.

+ Arduino ve Breadboardi yanyana yerlegtir

+

5V Akam Arduino 5V da galisir. Arduino'yu bilgisayara bagladiginizda aldigimniz gii¢

kurdugunuz devreleri galistiracaktir. Bilgisayarinizi Arduino'ya baglayarak dogru gerilimi

alabilirsiniz. 5V size zarar vermez bu ytizden devre icerisinde dokunmaktan korkmayin.




Elemanlar:

Pin 13 Arduino

LED
SZ (Light Emitting Diode)

Direng (330ohm)
(Turuncu-Turuncu-Kahverengi)
GND

(ground-toprak) (-)

+Bu LED yakma devremizin §emaS|dn]

LED 330Q Kablo
Direng

LED YAKMAK

LED 'ler (light-emitting diodes) bir ok elektroni
devrede kullanilan giiclii 151k kaynaklaridur.
Caligmalarimiza ilk olarak her elektronik
meraklisinin yaptig gibi led yakarak baslayacagiz .
Bir gogunuz igin ¢ok basit olabilir ama hem devre
kurma hem de programlama olarak bize katacaklar
seyler daha komplex projeleri yapmak igin bizlere
birer basamak olacaktir.

+ Bu boéliimde devrelerimizi kurmadan 6nce
kuracagimiz devre ile ilgili kisa agiklamalar
yer alir.

x1 x1 x3

+ Bu bdélimde, devreyi tamamlamak
icin gereken pargalar listelenir.

+ Devrenin nasil kurulacagini gésteren
semadir. Ozellikle yeni baglayan
arkadaglarin baglantilari kurmak igin
semayi dikkatle incelemesini tavsiye
ediyoruz.

+ Direng gibi devre elemanlarinin
breadboard ile baglantisini
saglamak i¢in bacaklarini 90
derecelik agiyla bikiiyoruz.
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. [P edit Sketch  Tools  Help

Bilgisayarimizdaki Arduino IDE yazilimini agiyoruz. Daha sonra asagidaki
semay takip ederek "examples" klasortii igerisindeki "Arduino Kod"
bolimiinden "Devre 1" kodunu segiyoruz.

New
Open...
Sketchbook »
1.Basics »
Close 2.Digital | 4
Save 3.Analog >
Save As... 4.Communication >
Upload 5.Control >
Upload Using Progammer 6.Sensors »
7.Displays | 4
Page Setup 8.5trings »
Print ArduinolSP
Devre #2
EEPROM Devre #3
Ethernet Devre #4
Firmata Devre #5
Liquid Crystal Devre #6
SD Devre #7
Servo Devre #8
SoftwareSerial Devre #9
SPI Devre #10
Stepper Devre #11
Wire Devre #12
//Devre #1

Circuit #1

7
Led Yakmak (Blink=G6z Kirpma)
LED 'i bir saniye yakip bir saniye séndiiren program
*

/

int LEDcikis = 13;
void setup() {

// Dijital Pini gikig olarak ayarlayacagiz.

pinMode(LEDcikis, OUTPUT);

}
void loop() { //LED'i yak

digitalWrite(LEDcikis, HIGH); // 1 saniye bekle
delay(1000); // LED'i sondiir
digitalWrite(LEDcikis, LOW); //1 saniye bekle

delay(1000);
}




Kodu derliyoruz. Yazilim kodu arduino tizerindeki entegrenin anlayabilecegi dile

geviriyor.

J Derleme‘

USB Kablo araciligiyla kodu Arduino tizerindeki entegreye gonderiyoruz. Daha sonra

devre otomatik olarak ¢alismaya baglayacaktir.

Yikleme

>

// Verilen kod ile derledikten ve yiiklendikten sonra breadboard iizerindeki LED yanip sonmeye baslayacaktir




+ Tum devrelerde kodlarin ne
oldugunu agiklayan boliimdiir.

‘ L Arduino IDE ‘yi A¢ // File > Examples > Arduino Kod > Devre # 1

Kod notlari: + Verilen Kodu derlemeyi(verify) o °
ve yiiklemeyi(upload) unutmayin

+ Kodun nasil galistigini anlamak icin
asagidaki agiklamari inceleyin.

Arduinoki pinleri kullanmadan 6nce pini INPUT (giris) yada
pinMode(13, OUTPUT); OUTPUT (gikss) olarak tanimlamaniz gerekmektedir . Bunu yapmak
icin pinMode() yerlesik fonksiyonunu kullanacagiz.

Bir pini OUTPUT (¢ikis) olarak tanimladiginizda, o pinin HIGH
(output 5 Volts-5 Volts ¢ikis), veya LOW (output 0 Volts-0 Volt ¢ikis)
olarak davranmasini saglayabilirsiniz .

digitalWrite(13, HIGH);

+ Devrenizi tamamladiysaniz,
asagidaki gibi LED yanip s6necektir

Ne gorecegiz?

Yanip sonen bir LED goreceksiniz. Eger
calismiyorsa kodu kontrol edin ve tekrar
derleyin sonra yiikleyin ve devreyi tekrar
kontrol edin veya asagidaki sorun giderme
ipuglarini bakin.

+ Bu alan kurdugunuz devrenin ve devre
elemanlarinin gergek hayattaki
kullanimlarini igerir.

+ Bu boliim devre montaji sirasinda yapilan
en yaygin hatalari igerir.

Sorun Giderme: Gergek Hayatta Uygulamalar::

LED Yanmryor Hemen hemen tiim modern televizyon ve
LED sadece tek yonlii galisir. Bu tiir sorunlar monitdrlerde tirtintin galistigini ya da standby
genelde LED in yanlis bacaginin baglanmasindan durumunda oldugunu gosteren LED ler bulunur.

kaynaklaniyor. Endiseye gerek yok Led in
bacaklarini ¢evirin ve yeniden baglayin.
Program Yiiklenmiyor

Yiikleme ile ilgili sorunlar genelde seri port dadr.
tools>serial port> sekmesinden portunuzu degistirip
tekrar yiiklemeye ¢alisin.

Hala Galismiyor mu?
Tamamlayamadigmiz her devreniz hakkinda yardim

almak igin emrearslan@elektrikport.com adresine mail o
yollayabilirsiniz. 8




Devre #2

Potansiyometre

+5 Volt Bu devrede potansiyometrenin ne ise yaradigini
Ogrenecegiz. Potansiyometre degisken bir direng
m Arduino Potansiyometre Arduino olarak bilinir. Tki gikis pini 5 Volta baglandiginda
Pin AG ortadaki pin potansiyometredeki kontrol
diigmesinin konumuna gére 0V ile 5V arasinda
¢ikig verir. Bu devrede, LED parlakligini kontrol
\V4 LED D - . . b
etmek i¢in potansiyometreyi nasil kullanacaginizi

Ogreneceksiniz.

diren¢  (3300hm)
(turuncu-turuncu-kahverengi)

GND
(toprak-ground) (-)

Potansiyometre LED 330Q Kablo
/ Direng
x1 x1 x1 x6

Elemanlar:




Devre 2: Potansiyometre
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J L Arduino IDE yi A¢// File > Examples > Arduino Kod > Devre #2

Kod Notlar1: 0 °
"Degisken" sizin isim verdiginiz bir rakamdur. Degiskeni kullanmadan
. 6nce onu tanimlamali veya bildirmelisiniz; burada sensorValue adinda
int sensorValue; |:> e g G b
bir degiskeni "int" (integer-tamsay1) olarak bildiriyoruz. Bu degisken
isimlerinin kiigtik-bityiik harf duyarh oldugunu unutmayiniz.

Analog pindeki degeri okumak i¢in analogRead()
fonksiyonunu kullaniriz. analogRead() kullanmak istediginiz

sensorValue = analogRead(sensorPin); :> analog pindeki ("sensorPin") degeri okur ve bir
rakama("sensorValue") doniistiiriir, bu rakam 0 (0 Volt) ile
1023 (5 Volt) arasindadur.

Arduino her saniye binlerce satir kodu galistiracak kapasiteye sahip, gok
hizli bir yapidir. Onu yavaslatip neler yaptigini gézlemlemek i¢in bazen

delay(sensorValue); :> kodlar arasina ("delay")gecikmeler ekleriz. Delay() fonksiyonu
milisaniye ile sayar; yani 1 s gecikme igin parantez igine 1000ms
yazilmalidir.

Ne gorecegiz?

Potansiyometrenin ayarini
degistirdikge LED'nin hizli ve
yavas bi sekilde yanip
sondiigiini goreceksiniz. Eger
calismiyorsa kodu kontrol edin
ve tekrar derleyin sonra yiikleyin
ve devreyi tekrar kontrol edin
veya agagidaki sorun giderme
ipuglarmi bakin.

Sorun Giderme: Gergek Hayatta Uygulamalar::

Diizensiz Calisma Durumu MP?3 galarlardaki ses kontrolii potansiyometre
Biiyiik olasilikla potansiyometrenin pinlerinin kullanimina bir 6rnektir.
breadboarda tam oturmamasindan
kaynaklanabilir. Potansiyometreyi bastirarak bu
sorunu ¢ozebilirsiniz.

Calismama Durumu
Potansiyometrenin 2. pinini analog pin yerine dijital
pine baglamadiginizdan emin olunuz.

Hala Calismiyor mu?

Tamamlayamadiginiz her devreniz hakkinda
yardim almak i¢in emrearslan@elektrikport.com
adresine mail yollayabilirsiniz.




Devre #3

RGB LED

Pin 11 Pin 10 Pin9

I i I I h I I i I Yanip sonen bir LED’den daha eglenceli sey nedir
sizce? Tabi ki renkli LED'ler! RGB, yani red-blue-
green LED'ler 3 adet renk barindiran ve her tiir

g;;z:;) renk i¢in kombin edilebilen bir diyot tirtdiir. Bu
P— devrede Bir RGB LED kullanarak nasil renk
- = T kombinasyonlar1 olusturabileceginizi
z = g 6greneceksiniz. Her bir diyotun parlakligina bagh
Av4 olarak neredeyse biitiin renkleri elde etmeniz
miimkin.
—1L _ GND
— (toprak-ground) (-)
é LED 330Q Kablo
E Direng
= x1 x3 x6




Devre 3: RGB LED
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* Uzun ug genelde (gnd)'dir. Bazen anot, katot degisebilir




%06

<~ (]0A 0) AOT
kA I | N |

< ()04 S) HOIH
%01

%05
pu <= (]040) AOT

nGT

< ()j0A <) HOTH

nso[qey| eureny

%01
< (104 0) AOT

wo 1l
& ()°A <) HOIH

nsojqey] ewepy

nso[qey| eureny

“mpuofznyt 1q ignded

updLIsTRNd Soreue ed198, unuourunpry nq 2387 “mppesedes ewredey

drde 1jziy eyep uspurdasaiqaros unze3 urd nyyund Imyede[ey YNUQS eyep
AT eSSTUIURDIRY JIeA B[ZEJ BUED PUNWUNUOY MO 1eyeq Tyeoeued
yepred qqT uepo 1i3eq sutd nq es10ATuRdOIEY JIRA B[ZE] BUERP BPUNTUNUOY
HOIH 1987 “ToATue[ny ruewrez ueuedsIey Yere[o \OT A HOTH IWMdJ
‘niqejedesy dide zoy 0001 opaAtues Turd J1q D J$T[ED I[Z1Y Jepey| 0 OUIpIy

JJIqernpAn 4oy

nq Yereue[ny (,UoNeMPO YPPIM-S[Nd,) WM Le[op uepuiseuro
11y Y0 unu,oumpry ewe Ipidap dryes eursnyr (ejoa Sofeue 11q
325198 oUMPIY “INYEIR[0 1242 WY JIALY WY ZIWTQRAID YeSIN[O YEILIOS
9£1p T TRA TUENWI 11q 1qIS YoULIaA ISTIY (e3j0A Soeue unu,0UMPIY BRI
“npao8 rurdpiqedAnyjo yereueny nuoLisyuoj ()peaySoreue (L1a[123ap

] epuisere (e)[0A G 24 () Lref(ejjoa Sojoue unuoumMpIy Iepey aA1purrd

nso[qey| ewrepy

nso[qey| eweny

nso[qey| eureny

Suam VOEE

Sua11q DOEE

Swaaq VOEE

(wrwg) a1 499

H[P31D DIPY YOS Plepuisey1y ()11 M Sofeue

BlluE e




JL Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 3

Kod Notlare:

for (x = 0; x < 768; x++)
{}

if (x <= 255)

zlse :>

{}

delay(sensorValue); :>

Ne gorecegiz?

LED'inizi galistyor olarak gérmeniz
lazim, fakat bu sefer LED'iniz
sirayla farkli farkli renkler yayiyor
olmal. Eger oyle degilse devrenizi
dogru sekilde birlestirdiginizden
emin olun, kontrollerinizi yapin ve
kartimiza yiikleme yapin ve ariza
tespiti kismuini kontrol edin.

Sorun Giderme:

LED'in Isik Vermemesi veya Yanlis Renk Vermesi
LED'in dért pini birbirine ¢ok yakin bulunmakta,
kolayhkla yerlerini karistirabilirsiniz. Pinlerin nerede

olmas: gerektigini iki kez kontrol edin. Ayrica uzun LED'kullamlm:aldadJr. Bu '
" . LED/ler ayn1 bolgede farkls
ug bazen GND olmayabilir, uzun ucu Arduino renkleri gostermek igin []
kartimizin 5v gikigina bag tekrar deneyiniz.
an 5v gilastna baglayp tekrar deneyiniz kullaniliyor. Siklikla farkl:
Kirmizi Rengi Gormek renkler farkh calisma U
RGB LED i¢ersindeki kirmiz1 diyot diperlerinden daha sartlarini ifade eder 5

parlak olabilir. Renklerinizi daha dengeli hale getirmek
i¢in daha yiiksek bir direng kullanin veya kodunuzda

ayarlamalar yapin.
analogWrite(RED_PIN, redIntensity);

to

analogWrite(RED_PIN, redIntensity/3);

Bir for() dongiisti bir aralikta say1 yerlestirmek icin kullanilir ve
tekrarlayarak brackets{} igerisinde kodu galistirir. Degisken bir “x” 0 olarak
basliyor ve 767 sayisina kadar her adimda bir artarak ilerliyor ("x++")..

“If / else” ifadeleri programinizda segim yapmak i¢in kullamlir. Parantez ()
icerisindeki ifade degerlendirildiginde, eger ifadesiniz dogru ise ilk brackets{}
icerisindeki ifade ytiriitiiliir. Sayet dogru degil ise ikince brackest {} igerisindeki
ifade yiiriitiiliir.

Arduino ¢ok hizh ¢aligbilmektedir. Oyle ki her saniye binlerce kod
satirini gahistirabilecek kapasiteye sahiptir. Biz de cihazin ne yaptigini
gorebilmek i¢in yavaslatmak adina gecikmeler ekliyoruz. Delay()
milisaniye olarka hesaplaniyor; 1 saniye 1000 milisaniye.

Videogame konsollar gibi
bir gok elektronikte RGB =




Elemanlar’

Coklu LED

Elimizde yakip s6ndiirmek igin bir LED var. Gelin
simdi SEKIZ LED'i anda baglayarak gitay1 biraz
yiikseltelim. Boylece ¢esitli renkler olusturma
konusunda Arduinomuzu da ufak bir teste tabi
tutmus olacagiz. Bu devre kendi programinizi yazma
pratikleri igin giizel bir baglangi¢ adimi olacak.
LED'leri kontrol asamasinda yazdiginiz programi
diizenli tutmanizi saglayacak bir kag ipucu
Ogrenceksiniz.

for() loops - Bu dongii birden fazla kez aym
kodu kullanmanizi saglar.

arrays[ ] - Birden fazla degiskeni grup haline
getirerek yonetilmelerini kolaylagtirr.
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Devre 4: Coklu LED
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